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User manual
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. Introduction

Binic is the first program | distribute through share/freeware canal. | hope you will
like it and it will be useful.

This Windows version is a complete rewriting of an old DOS version | wrote in
1991.

If you enjoy and/or use it, please send me a postcard of your home town. If you
have time enough, feel free to add any comments, remarks or suggestions you
may find appropriate.

My adress is :

Benoit Marchal

Rue Lucien Naméche, 13

B 5000 Namur

(Belgium)

It is, of course, as useless as expensive to send it by express or plane. Keep it
cheap but, please, do write.

This program represents hours of work. It has been carefully tested and checked
against bugs and inconstancies. Writing the documentation in english required a
tremendous effort for me.

For all that work, | just ask you a very simple thing : send me a postcard. | just
would like to see how far it will go and how many people will use it.

For sure, | made mistakes. Please be tolerant. As | told you this is a first
experiment : things can only improve.

If you don't like it, you may also write to me and tell me why. | may improve only if
| know about my mistakes.

OOO\I@O'IJ}-OON—\O



1. Installation
Caution ! If you receive Binic as a ZIP archive, you must decompress it with the -
d switch to create directories store in archive.

Use the INSTALL program found on the distribution disk to install Binic. INSTALL
will place the files into a sub-directory on your hard disk and add Binic's icon to
the Pineapple group of the program manager. All further references to Binic in
this file assume you've used INSTALL's default installation.

To run the installation program from Drive A type :

WIN A:INSTALL

or, if Windows is active, select the program manager's File|Run command and
type :

A:INSTALL

validate with the OK button.
Now, just follow instructions given by INSTALL. Normally, all you have to do is
choose a directory to copy Binic in and make sure distribution disk is in your
drive.
2. What is Binic ?
Binic is an simple though useful program designed to handle those boring
conversions between the various number representation in computer science :
hexadecimal, decimal and binary.
It's rather a programmer tool than an end-user tool.
In addition to immediate translation from one representation to the other, Binic
offers some useful services like copy/paste to and from the clipboard or bit mask
to ease manipulation of binary expressed numbers.
Main features of Binic are :
instant translation from one representation to the other for speed
data type management to avoid stupid mistakes
clipboard management which ease importing to and from various editors
bit mask to ease bit manipulations
settings saving.
3. System Requirements
Binic requires Windows 3.0 or higher version, a 80286 CPU or above (i386, i486
or compatible). Windows must run in protected mode.
Binic won't run in real mode or on a 8088/8086 base system.
4. How to use Binic ?
This manual assumes you already know how to perform basic operations with
Windows like clicking, selecting an item in a menu,..., that you are aware of the
clipboard,... If it is not the case, please refer to the Windows guides. It also
assumes you're having a mouse which is a quite normal assumption under
Windows environment.
Before anything else, we must define a few expressions use in this manual.



The current number is the number you currently edit. This is the number displays
in the three edit field of Binic, the one you can change.

The data type is the length (in bit) of the current number. In a computer number
are represented by a various number of bit. 8 bits are called an octet, 16 bits are
a word (at least on PC) and 32 bits are a double word. On an octet, you can code
256 different numbers, more on a word or on a double word. A number can also
be signed or unsigned. This is also part of the data type.

Example : 90 in hexadecimal is 144 in decimal if coded as an unsigned byte, -
112 if coded as a signed byte and 144 if coded as a word or double word (signed
or unsigned). Binic can automatically handles those differences. This can ease
some manipulations.

A switch option is an option which can be active (or on) or inactive (or off). l.e.
two mutually exclusives states.

To start Binic just double click on its icon in the program manager. Binic main
window displays. It should look like this :
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Note that actual colors may vary depending on your system.
To enter a number, just select the appropriate field by clicking on it with the left
button of your mouse or by using keyboard shortcuts :

Al+H : hexadecimal



Alt+D : decimal

Alt+B : binary,
and type the number of your choice. Note that while you enter a number in a
field, other field are immediately adapted according to change.
Example : select the hexadecimal field by clicking anywhere on it, now type 59
(I.e. 89 in decimal), decimal field is now 89 and binary field 0000000001011001,
reflecting the new value you entered. As you can see, adaptation is immediate.
Note : actual number of 0 in binary field may vary decimal value may be different
depending on the current data type. Don't mind, you'll quickly learn how to
change this.
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Quick change's buttons are a easy way to increment or decrement current
number. The "+" button add 1 to the number, the "-" button substract one from the
number.

Example : now, click on the "+" button, number change to 90 in decimal, l.e. 5Ain
hexadecimal or 0000000001011010 in binary.

And now the secrets of the menus.
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Paste : paste number representation from the clipboard, you're prompted to know
in which representation is the number in the clipboard. If no data are available in
the clipboard, this item is grayed.

Combining these two commands, you can easily import a number in one
representation (say decimal) from your text editor, convert it into binary
representation and copy it back to your text editor.

Clear : just set to zero current number.

Bit mask : display bit mask. Bit mask is a convenient way to set or unset a
particular bit. Bit mask dialog box looks like this :
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Actual Bit mask dialog box may vary on your system, according to the data type
you use. Don't mind, you'll quickly learn how to change data type.

There is a check box by bit of the current number. When the bit's value is 1,
associated check box is checked, when bit's value is 0, associated check box is
unchecked.

You can quickly change a bit value by checking or unchecking it's corresponding
check box.

Example : to set bit 5, click on Bit 5 check box, validate with OK button. Current
number is now 0000000001111010 (l.e. bit 5is 1) or 122 in decimal or 7A in
hexadecimal. As usual, number modification is immediately reported to all three
representations.

This is easier than having to count 4 digits before typing 1 in the binary field but
otherwise it is the same. This feature is particularly pleasant with long data type
like double word (32 bits).

Exit : as you've probably already understood, this item is use to exit Binic. Don't
try it now, there are still some features of Binic to discover.

Note : keyboard short cut in this menu are the new ones, Mac-like, as use by
Microsoft in Windows 3.1. But the old ones (Shift+Del, Ctrl+Ins & Shift+Ins) are
still available.
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As promise here is how to select data type. The Format menu is where you do
this : byte, word or double word, signed or unsigned.

The items are divided in 2 groups :

Signed/Unsigned : to choose whether data type is signed or not
Byte/Word/Double word : to choose the size of the internal representation of data
type.

In each group, items are mutually exclusive l.e. only one item at a time can be
selected. The currently selected item is shown by a check mark (O) beside it.
When you select an item in a group, the currently selected one of that group is
automatically deselected.

Note that with the current version of Binic (2.0.0), you can't select an unsigned
double word. So Signed and Unsigned items are grayed when you select Double
word and Double word is grayed when you choose unsigned.
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The Options menu offers the following item :
Confirm exit : this is a switch option, when on you're prompted for confirmation
before leaving Binic. When this option is on, a check mark (O) appears beside
the item.
The following items concern saving of Binic's settings. Binic can save it's current
settings when asked.
When it reopens, Binic reads those settings and set himself according to them as
if you select them in the menus. This feature allows you to gain time.
The settings Binic can save are :

confirmation of exit (see below)

automatic save of settings on exit (see below)

data type.
Now let's have a look at those famous commands :
Save settings now : this command save current settings of Binic at the time you
select it.
Save settings on exit : this option ask Binic to automatically save current settings
when you exit. It is equivalent to select Save settings on exit just before closing
Binic. This is a switch option. When this option is on, a check mark (O) appears
beside the item.
When you turn this option off, you're prompted to save it.

an00000000HO$O00INOOODon7-0+00(00003e0e0000000000000BITMAPO»000
¢Ayy>NO00000«0$000000000000000000000000000000000000000000WO00000
0O0o0oooooooooooooooooooooooOroOoo0o0oo0o0oo0o0o00o0000o0000000O
c00000000000000000000000000000000000I00000000000000000000000000000



000000vOD000000000000000000000000000000000eX=59yyyyyyyyyyyyyyyyyyyy
yyyyyyyyyyyanoooooooooooooooooooooooooooooooooooooooooooponooooona

000000000000000000*000000000000000000000000000000000000=99yyyyyyy
yyyyyyyyyyyyyyyyyyyyyyyyanoooooooo0000oo0000ooo000ooo0ooooooooooooon
0000000000000000000000000000000000000000000000000000000000000000O

DOE=yyyyyyIyyyyyyyyyyyyyyyyyyyyyyyyyyenon0000000000000000000000000000
00000000YYYYYYYYYYVYYYYVYYYYYYVYYYYVYYYYYYOYYYYYYyyyyyyyvyyyyyyyyyyyyyy

Yyyyyp%ﬁyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyaDDyyyyyyyyyyyyyyyyyyyyyyyyyyy
yyyyyy€00000000000000000000000000000000000€0000000000000000000000
0o0ooooooooooen|

DOe=y59yyyyyyyyyyyyyyyyyy9yyyyyyyen0yyo0000000000000000000000000000
00€00000000000000000000000000000000000€00000000000000000000000000

000000000vVIDOE=yyyyyyy9999yyyyyyyyyyyyyysssya
0yy0OO00ooo0000oo00000000000000000,0000000000000000000000000000000
0000€00000000000000000000000000000000000<0]

DOE=yyyyyyyyyyyyyyyyyyyyyyyyyyyyyyen0yyn0000000000000000000000000000
00€000000000000000000000000000000000000000000000D000000000000D000
00000oo0En)

DOe=y59yyyyyyyyyyyyyyyyyyyyyyyyyyen0yyo0000000000000000000000000000
D0€0000000ADDN000000000000€00000000000s000000AD00000000000000€00
000000000€0|

DOe=95999yyyyyyyyyyyyyyyy99yyyyyyyarnyyon00An00000000000000€000000000
00,e000000&00000000000000™€00000000€00€
000000&00000000000000™€00000000€n0en|

OO==y Yy Yy yyyyyyyyyyyyyyyyyyyyyyyyyei0yyon0annoooooooooooo ™€noooooon
€00€0000000600000000000000°000000000€00€0000000600000000000000°000
000000€n0fa|

DOEEyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyunnyyon00600000000000000°000000000€
DDfDDDDDDDOD3><DD0m50yYDDHGDOUADD€DDDDDDDO[]>

0’?5hyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyw poeioooo030 33338 O TMOL) TM TM TM TM T TM T ~
g™ ™enEnnnonnnU3n333?000™yYa™ ™™ g™-n€nn€nnnooon03n333?

ODDTMYUTM ™ TM~ I:ITM D€DD€D|

’?EhyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyuI ﬂ€ n000130333000 ™ 0™ ™ ™™ noo€nn f
agooooni3n333o00™pgog™ ™ ™ IMTNNENNE

00000013p333000™ 0pg™ ™ ™ ™-Op€NDEQ|

OO==y Yy Yy YyYyYyyyyyyyyyyyyyyyyyyyyennyynnnidn333o00™aog™ ™ ™ ™naneq
0€0000000G30333300™ g™ ™ ™ ™ TM TM M~ TM TMENEN00000C30333300™ 10

TMTMTM TM TM TM TM~™ DTMTM€DI:|f|:||

DOy yyyyyy99yyyyyyyyyyyyyyysyyaenyynooC3n333300 ™ ™ m m m



"™ ™ENI€N0N0000A 0 3 000t0066I™ 0A"10GANNENINONONA 0 3

000100081 ™ DA N0BANDED|DOEYYYYyYYYYyIIyyIIyyyyyyyyyyyyyennyynnoA o 3
000t0066i™ DA"00GANNENNNN000000000000000000000€000000000€00000000
00000000000000000€n00000000<€n

DOe=y59yyyyyyyyyyyyyyyyyy9yyyyyyyen0yyo00000000000000000000€0000000
00€0000000000003000000000000€000000000€0000000000003000000000000€
000000000€0|

DOE=yyyyyyyIyyyyyyyyyyyyyyyyyyyyyyen0yyn00000003000000000000€0000000
00€000000000000 00O00D0000D000D0000000oEn00n0000n000O
0000000000000000000000ED|

OOy Yy yYYyyyyyyyyyyyyyyyyyyyyyyennyynoooooon
0000000000000000000000€00000000000000000000000000000000000€000000
00000000000000000000000000000€0]

DOE=yyyyyyyyyyyyyyyyyyyyyyyyyyyyyyen0yyn0000000000000000000000000000
00€00000000000000000000000000000000000€00000000000000000000000000
000000000€0|

0000000000D0000D00000000000000000e00D0000D0D00D0D00OD0000D0000D00a

0000€00YYYYYYYYYYYYYYYYYVYYYYVYYYYYyYyYYENOYYVYYYYVYYYYVYYYYVYYYyYyyyy

YYYYYVEDE=GYIYYIYYYIIIVIyYYIIIIVIyyyyIIIyennyyyyyyyyyyyyyyyyyyyyyvyyy
YYYYYYYYELNYYYYYYYYYYYVYYYYVYYYYYYYYYYYYYYYYEDDYYYYYYYYVYYYYVYYYYVYYYYY

YYYYYYYYYET=GyYYYYYYIYIIIIIIIIyyyyyYyIyyyIIyennyyyyyyyyyyyyyyyyyyyyyy
YYYYYyVyyyYEDOYYYYYYYYVYYyyVyYyyyyyyyyyyyyyyyyyEOoyyyyyyyyyyyyyyyyyyyyy

YYYYYYYYYYYVETe=yyYYYYIIIIIIIIIyyYYYIIIIIIIIyyennyyyyyyyyyyyyyyyyyyy
YYYYYyVyyyyyyyEOOyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyeaoyyyyyyyyyyyyvyyyyy

YYYYYYYYIYYYVEDE=GYYYIIIITIIIYYYYYIIIIIIIIIYYYyenyyyyyyyyyyyyyyyy
YYYYYYVYYyyyyyyyyENOyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnayyyyyyyyyyyyyyy

YYYYYYYYYIIYYYVEDE=GYIIIITIIYYYYYIIIIIIIIIIYyyyyeiayyyyyyyyyyyyy
YYYYYYVYYYYYyYyyyyYyENNYYYYYYYYYYYYYYYYVYYYYYYYYYYyVyyyyENDYYYYYyVyyyyy

YYYYYYYYYIIIYYyyyyYETEEGYYYIYyYYYYIIIIIIIIIIYyyyyyyyenyyyyyyyyyy
YYYYYYVYYYYVyYyyyyyyyyyEIOYYYYYYYyYYYYyVyyyyyyyyyyyyyyyyyyyEooyyyyyyyyy
YYYYYYYYYIIYYYYYyyyYYYVETE Ty YYYYYIIIIIIIIIYyyyyyyyyyyennyyyyyyy
YYYYYVYYYYYYYYYyyyyyyyyyyyEDOYYYYYYyYyYyyyyyyyyyyyyyyyyyyyyyyyeEnnyyyyyy

YYYYYYYYYYYYYyyyyyyyyyyyyVEDSYYYYYYYYYYYYYYYYYYYYYYYYYYYYYyyyyennyyyy
YYYYYVYYYYYYYYYyYyyyyyyyyyyyvENnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnoyyy

YYYYYYYYYYYYYYyyyyyyyyyVEDSYYYYYYYYYYYYYYYYYYYYYYYYYYYyyyyyyenny
YYYYYVYYYYYYYYYYYYYyYyyyyyyyyyyyEDOyYYYYYyYyYyyyyyyyyyyyyyyyyyyyyyyyenn

A N N S s N A N A
OOYYYYYYYYVYYYYYYYYVYVYYYYYYVYVYyYYEOOyYYYYYYYYYYYVYVYYYYYYVYYYYYYYYYYY
€O0YYYYYYYYIYYYYYIYYYYYIYYYYYIYYYYYVENyYIYYYYYIYYYYYIYYYYYIyyyyyyyyyy
VYo OOyYYYYYyYyYyyyyYyyyyyyyyyyyyyyyyyyEnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyy
YYYEOOYYYYYYYYYYYYYVYYYYYYYYVYYYYYYYYYVELEYYYYYYYYYYYYYYYYYYYYYYYYYYyY
YYYYYoUUYYYYYyYyyYYyYYyYYyYyyYyyYyyyyyyyVENDYYYYYY Iy IV YyYIYYIyIYyyyyy
YYYYYVEOOVYYYYYYYYYYYYYYYYYYYYYYYYYYYYYVYVELEEYYYYYYYYYYYYYYYYYYYYYYYYY
YYYVYyyYeLUYYYYYYYyYYyYYYYYYYYYyYIyyYYyyYyyYENLYyYYyYYyyYYyYYyyIyyyyyyy
YYYYYYYYYEDYYYYYYYVYYYYYYYYVYYYYYYYYYYYYYYYYETEYYYYYYYYYYYYYYYYYYYYYY
YYYYyyyyyyyenuyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnuyyyyyyyyyyyyyyyyyyyyy




YYYYYYyyyYYYEINYYYYYYYYYIYYYYYIYYYYYIYyyyyIyyyyvEIecyyyyyyyyyyyyyyyyyyy
YYYYYyyyyyyyyyenayyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyennyyyyyyyyyyyyyyyyyy
YYYYYYYYyyyyyyyENOyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyeeeyyyyyyyyyyyyyyyy
YYYYYYYYyyyyyyyyyenyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyvenayyyyyyyyyyyyyyy
YYYYYYYYyyyyyyyyyyENOyYYYYYYYYYYYYYYYYYyVYyyyyyyyyyyyyeENE=yyyyyyyyyyyyy
YYYYYYYYYyyyyyyyyyyyednyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyennyyyyyyyyyyyy
YYYYYYYYYyYYyyyyyyyyyEOnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnesyyyyyyyyyy
YYYYYYYYYYyYYyyyyyyyyyyenayyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyeonyyyyyyyyy
YYYYYYYYYYYYYYyYYyyyyyyYENOYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYVEDEEYYYYYyY
YYYYYYYYYYYYYYyyYyyyyyyyyyeOnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyenoyyyyyy
YYYYYYYYYYYYYYYYYYYYYyYyyyYEODYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYyEN=yyyy
YYYYYYYYYYYYYYYYYYyyyyyyyyyyyennyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyennyyy
YYYYYYYYYYYYYYYYYYYYYyYyyyyyyYEOnyYYYYYYYYYYyYYyyyyyyyyyyyyyyyyyyy€nesy
YYYYYYYYYYYYYYYYYYYYyyyyyyyyyyyyennyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyenl
yyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyy€|] |]yyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyy€|]

_______ @Eyyyyyyyyyyyyyyyyyyy
YYYYYYYyVEDREyYUn0yYyyYyyYYyyIyyyyyyyyyyyyyyyyennyyanoyyyyyyyyyyyyyyyy
YYyyyyyyyyyyEnuyyonunyyyyyyyyyyyyyyyyyyyyyyyyyyyyENnyyoyoyyyyyyyyyyyyyy
YYYYYIYYYIyyYVETEyYONOYYYYYYIYYYIYYIYYIYyyIyyyyyyyenyyonnyyyyyyyyyyy
yyyyyyyyyyyyyyyyyeoogyya?
OYYYYYYYYYIyyYyyyyyyyyyyyyyyyENOYYIvYyIyyYyIyyIyyIyyvyyvyyvyyyyyyEneeyy
a?iyyyyyyyyyyyyyyyyyyyyyyyyyyyyeioyya?

[]yyyyyyyyyyyyyyyyyyyyyyyyyyyy€[| |]yyAyAyyyyyyyyyyyyyyyyyyyyyyyyyyyy€[| []yy

...............

yyyyyyyyyyyyyyyyyyyyyyyyyyy€DDyyﬁayy¢yyyyyyyyyyyyyyyyyyyyyyyyyyy€D%%yyD
yaryyyyyyyyyyyyyyyyyyyyyyyyyyyenoyyoya?
YYYYYYYYYYYyyyyyyyyyyyyyyyyENnypayoyyyyyyyyyyyyyyyyyyyyyyyyyyyenaypyyy

RYYYYYYYYYYYyyyIIIIIyyyyyyyEDe=ybOyOyYyyyYyyyyYyyIIIyyyyyyyyyyennypn
yéyyyyyyyyyyyyyyyyyyyyyyyyyyy€D I:lyp Dy6yyyyyyyyyyyyyyyyyyyyyyyyyyy€D Dyby

...............

...............

y9p96Dyyu9yyy§§¥ﬁyyybgyybgyyyyyyyyyzDDyuD06Dyyunyyaeﬁfyyybgyybgyyyyy
yyyy€nnyennanyyay



60ADpYD






60ADpYD






60ADpYD






60ADpYD



ooyaooo I]yyyyyyyyyyyyyyy5yyyyyyyyyyy€D gya



....... .

I



OOVYYYYYYYYYyyyyyyyyyyyyyyyyyenoyun



O0yYyyyyyyyyyyyyyyyyyyyyyyyyy€ooypa?
OYYYYYYYYYYyyIyyyyyyyyyyyyyyENDYOyYyRYYYYYIYYIYYIYYIYYIyyIyyyyyyETE=-ypb
070YYyYYyyyyyyyyyyyyyyyyyyyyyyenoypo?
OYYYYYYYYYYYYyyyyyyyyyyyyyyy€noypo?

OYYYI9IIYYyyyyyyyyyyyyyyyyvECTYPYTIRYYIIIIIIIIIIIIIIyyyyyyyyyyy fOeeib
0 ? POYYYYYYYYYYYYYYYYYYYYYYYYyyye-l Y_b D ?

€?%yyyyyyyyyyyyyyyyyyyyyyyyyyy€ﬂﬂyyA?
Dyxyyyyyyyyyyyyyyyyyyyyyyyyyy€DDyyBybyyyyyyyyyyyyyyyyyyyyyyyyyyyy€

Dyyyyyyyyyyyyyyyyyyyyyyyyyyyyf)Dyya7 .......

N A D e e e s Y
OVYYYYYYYYYYYYYyyyyyyyyyyyyyya nyya?oyyyyyyyyyyyyyyyyyyyyyyyyyyyyf ayyo






OYYYYYYYyYyyyyyyyyyyyyyyyyyyyennyyo



Dyyyyyyyyyyyyyyyyyyyyyyyyyyyy€DDyVUDDyyyyyyyyyyyyyyyyyyyyyyyyyyyy€DDyy

VVVVV€DDVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVVV€DEﬂ&yyyyyyyVyyyyyyyyyyyyyyyyy
YYyyyyyelnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyenuyyyyyyyyyyyyyyyyyyyyyyyyy
YYYYYyYYEONYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYEIEyYYYYYYYYYYIYYYYYYYYYYY
YYYYyyyyyyeinyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnnyyyyyyyyyyyyyyyyyyyyyy
YYYYYyYYYyYENOYYYYYYYYYYYYYVYYYYYYYYYYYYYYYYYYYEDeeyyyyYYYYIYYyyYyyyyyy
YYYYyyyyyyyyyenayyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnnyyyyyyyyyyyyyyyyyyy
YYYYYyYYyyyyYYENOYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYVEN=YYYYYIYYYYYYYYYYY
YYVYYYYyYYYyyyyyelnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyveEnyyyyyyyyyyyyyyyy
YYYYYYYYyyyyyyyyyEOnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyenesyyyyyyyyyyyyyy
YYYYYYYYyyyyyyyyyyyenyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnnoyyyyyyyyyyyyy
YYYYYYYYYyyyyyyyyyyyENOyYyyYYYYYYYyyyYyyyyyyyyyyyyyyyyyyeOeeyyyyyyyyyyy
YYYYYYYYYYYYyyyyyyyyyyenayyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnnyyyyyyyyyy
YYYYYYYYYYyYYyyyyyyyyyyENOyYYYYYYYYYYYYYYYYYYYYYyYYyyyyyyyvEN=yyyyyyyy
YYYYYYYYYYYYYyyyyyyyyyyyyeanyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyennyyyyyyy
YYYYYYYYYYYYYYYYYyyyyyyyyyENOyYYYYYYYYYYYYYYYYYYYYYYYYYyyyyyyyelesyyyyy
YYYYYYYYYYYYYYYYYYYYyyyyyyyyennyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnnyyyy
YYYYYYYYYYYYYYYYYYyYyyyyyyyyyENOyyyyYyyyyyyyyyyyyyyyyyyyyyyyyyyyyenesyy
YYYYYYYYYYYYYYYYYYYYYYYYyyyyyyyennyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyeny
YYYVYYYYYYYYYYYYYYYYYYYyYyYyyyyyELDYYYYYVYYYVYYYYYYYYYYYyyyyyyyyyyyyel

YV YV YYYYYYIYIIIIIe ey yyyyyyyIIIIyIIyyyyyyyyyIIIeyy
€O0YYYYYYYYYYYYYYYYYYYYYYYYYyyyyyyyyENOYYYYYYYYYYYYYYYYYYYyYyyyyyyyyyyy

VEDE=YYYYIIIYYYYYYYYYYYYYYIIIIyyyyyyyennyyyyyyyyyyyyyyyyyyyyvyyyyyyyyy
YYYEDOYYYYYYYYYYYYYYYVYYYYYYYYyyyyyyyyyENQYYYYYYYYYYYYYYVYVYVYYYYYYyyyy

yyys__/ﬁp?Ehys_{x_{x_{s_{x_{x_{x_{yyyyyyyyyx_{x_{x_{yyyyyyyyyyyyyzDDyyyyyyyyyyyyyyyyyyyyyyyyyyy
yYyyyyENNyyyyyyyAIOOOOOOyyynoooooo?
yyyyYyyENDyYYyyyyAIDOnonoyyyooonono?

yyyyyyyETeeyyyyyyYAINDN0n0yyyoooonoo?
yyyyyyyelyyyyyyyAdOOOO0Oyyyooooooo?
yyyyyyyennyyyyyyyEnnoooooyybyyyyyyyRyyyyyyyEOyyyyyyyennoooooyybyyyyy

YYRYYYYYYYENE=y Yy yyVENINO0O0yYbyyyYyyyRYYYYYYYelnyyyyyyyEN000000yyby
YYYyyyYyyyyyyvENQyyyyIvyYVyyIyycyypyyyyyyyRYIYYYIYEDNYYYIIYYYyIvyycyy

bYYYYYYYRYYYYYYVENE=YYYYYYY YYVIIYCYVOyyIYIyYRYYYYYYYelnyyyyyvyYyyyyyy
CYYbyyyyyyyyyyyyyye DDyyyyy,yyYyyyynyyybADDDDDDByyyyyyy€DDyyyyyyyYyyy

yyyeyybAINONOORYYYYYYYENE=LYYYYYYYYYYYyyyeyybANNNO0ORYYYYYYYanIyyyyyy
yYyyyyny-yybyyyyyyyyyyyyyy€DDyyyyyyy DDDDDDgnyoADDDDDDByyyyyyy€DDyyyy

yEOOYYYyyyy™ I]UUUP[IQWbADI]I]IIIDI]BWYWW@ZI’?EEWYWW DUUUPDgyybADDDDD
DRYYYYYYYelnyyyyyyy Yy yEyybyyyyyyyyyyyyyyEnnyyyyyyy n00000gyybAnnn

DO0BYYYYYYYENDYYYYYYy 100000g9yYbANDODDORYYYYYYYENE=LyyYYyyY n00000gYY
pADDOOOORYYYYYYYeOOyyyyyyyYyyyy=yEyybyyyyyyyyyyyyyyEDnyyyyyyy 100000



ayybAINONONRYYYYYYYENOYYYYYYY 000000gyYPAIDONONRYYYYYYYEDEYYYYYYY T
00000gYYPADNODODRYYYYYYYeOnyyyyyyyYbyyyyyLyybyyyyyyyyyyyyyyENnyyyyyy

y"0000009yYPADDDOO0RYYYYYYYEDDYYYYYYyY D00000gYYPATDONDIRYYYYYyyEne=y
yyyyyy 00o000gyypADDDDOORYYYYYYY@OuyyyyyyyYyyyy+yEyybyyyyyyyyyyyyyyen
Dyyyyyyy 000000gyyPANDDODORYYYYYYYVENDYYYYYYY 000000gyyPANODODORYYYYY

yyENEELyyYYYYY 000000gyyPADNDDONRYYYYYYYanIyyyyyyyYbYYyyytyybyyolyyyy
YYYyyyENnyyyyyyy” I]DDDDDgyyloADDDDDDByyyyyyy€DDyyyyyyy DDDDDDgnyDADDDD

DORYYYYYYYEDR=yYyyyyy 1000009yYpANNDONORYYYYYYYeOnyyyyyyyYyYYy+y1yy
byyAIYYYYYyyyYVENDYYYYyYy 000000gyyPADODODORYYYYYYYVENDYYYYYYY 0000009

yyloADElDDDDByyyyyyy€D?EEyyyyyyy 0000009YyPADDOOOORYYYYYYye0yyyyyyyYpl

yyyiyybyyélyyyyyyyyyyﬂ]Dyyyyyyy 000000gyYPANNNONORYYYYYYYEDDYYYYYYY T

000009YYPADNDDONRYYYYYYYEN=LyyyyYYy 000000gyybADNDODORYYYYYYYyanOyyy
yyyyerexxwyiyybyyélyyyyyyyyy€[|Dyyyyyyy DDDIJDDgyybADDDDDDByyyyyyy€DDy

GEDYYYYYYyYDoo3?

yEyybyyoLIyyyYyyyyyENNyyyyyyy 100000gyyPANONONORYYYYYYYENNYYYYYYY 000
000gyybANDDOOORYYYYYYY, Te=yyyyyyy 100000gyYpANDNNONORYYYYYYYUNOYYYYYY
yqu63 yiyybyyoLlyyyyyyyyy€E|Dyyyyyyy DuunungyybADDDDDDrsyyyyyyyMDyyyy

OyyyyyyyYpudereytyybyyo



19999999990 0yyyyyyy 00000 NgyybADOD 000BYyyyyyyyooyyyyyyy 00000 DQWDAD 00

I I{lg[]fl,yyyyyyyf Or=Lyyyyyyy 1000009yyPAIDIDDDORYYYYYYYUENYYYYYYYYYUOy Ty
ybyyo



Iyyyyyyyyy DDyyyyyyy DDunungyybADDDnunfsyyyyyyy€unyyyyyyy D[II]DI]EIQWlOAD

DDDgnyoADDDDDDByyyyyny?E&yyyyyyy DDDDDDgyyloADDDDDDByyyyyyquDyyyyyy
yqu@xwy;tyybyyolyyyyyyyyy Dyyyyyyy DDDDDDgyybADDDDDDByyyyyyy€DDyyyyyy

Dyyyyyyy 000000gyybADDONOORYYYYYYY fWesyyyyyyy 000000gyybAINOODNORYYY
YYYYOCOyYyyyyyYyyyy+y1yybyyyyyyyyyyyyyy.Unyyyyyyy 000000gyybADODO0oRy

YYYYyyyENuyyyyyyy DDDDDDgnyoADDDDDDByyyyyyy€D?EEyyyyyyy DDDDDDQWbADDD
DO0RYYYYYYYUnOyyyyyyyYpyyyyyEyybyyyyyyyyyyyyyyEnoyyyyyyy 000000gyybAL

00000RYYYYYYYENOYYYYYYY DDDDDDgyybADDDDDDByyyyyyyM’?f&yyyyyyy 0o0ooongy
yPADODODORYYYYYYYannyyyyyyyYyyyy+y1yybyyyyyyyyyyyyyyEnnyyyyyyy IUUUP

DgyyloADDDDDDByyyyyny‘SDyyyyyyy DUUUPDgnyoADDDDDDByyyyyyy€D%€&yyyyyy
y [lUUUPDgyybADDIJ[lnnrsyyyyyyy@nElyyyyyyyYy*“"a yiyybyyyyyyyyyyyyyy€nDyyy

yyyyyyyYyyyyyycyybAﬂDDDDDByyyyyyyﬁnﬂyyyyynyDDDDDDyybyyyyyyyyyyyyyy€
DDyyyyyyyYyyyynyyybyyyyyyyByyyyyyyDyyyyyyyYyyyyyygyybyyyyyyyByyyyyyy

€My Yy Yy Y YYYYYYeyybyyyyyyyRYYYYYYYAEDYYYYYYYEN000000yYPEOINNO0YYY
yyyyfSayyyyyyyEnnoonanyypyyyyyyyRyyyyyyyennyyyyyyyEno00000yybyyyyyyy

BYYYYyyyETE=yyyyyyyE0000000yYPyyyyIvyRYYYyyye TOyyyyyyy€0000000yybOn
0000DyYyyyyy€nnyyyyyyyAnoonoooyyyoooooon?
yyyyyyyENDyYyyyyyADDOno00yyyoooooon?

yyyyyyyETEeyyyyyyYAINDN000yyyoo0ooooo?
yyyyyyyunayyyyyyyAOODnooooyyyooooooo?
YYyyyyy.UOyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEOVYYyyyyyyyyyyyyyyyyyyyyyyy

VY YYYVEDE YTy I I T I IY I @0y Iy Iy
YYYYYYYYYELUYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYIYVECTYYYYYYYYYYYYYYYYYYYYYY
YTV O YT I I i@ e gy
WIYYIY VY DSV IV YY VYTV VYV YT IV VY99, I0VY YT TSV IV Y9y 9yy

YYYYYYYYYIIYYVEDE=GIYIIIIIIIIYYYYIIIIIIIIIIIyennyyyyyyyyyyyyyyy
YYYYYYVYYYYVyYyyYySOyYyYYyYyVyyyyvyyyyyyyyyyyyyyyyyyyQOyyyyyyyyyyyyyyy

YYYYYYYYYyyyyyyyyyUREyyyyyyyYYYYYYYYYYYYYYYYYYYYYYYyyan oYy
YYYYYYVYYYYVyYyyYyYTOYYYYYYVYYYYYYYYYYYVYYYYVYYYyyyyyYEPOVYYYYYYYYYYYYY

YYYYYYYYYYYYYYYYYYVE@EGTIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII@00GIIIIIIIITY
yyyyyyyyyyyyyyyyyyyyyy,"QyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyﬁDyyyyyyyyyyyy
YYYYYYYYYIIYYYyyyYYETEEGYYTIYyyYYYYIIIIIIIIIIyyyyyyyyenyyyyyyyyyy
YYYYYYVYYYYVyYyyyyyyyyyEIOYYYYYYYyYyYYyVyyyyyyyyyyyyyyyyyyyeooyyyyyyyyy
YYYYYYYYYYYYYYYYyyyyyyVEDSYYYYYYYYYYYYYYYYYYYYYYYYYYYYyyyyyennyyyyyyy
YYYYYVYYYYYYYYYyYyyyyyyyyyEDOYYYYYYyYyYyyyyyyyyyyyyyyyyyyyyyyyEnnyyyyyy
YYYYYYYYYYYYYyyyyyyyyyyyyVEDSYYYYYYYYYYYYYYYYYYYYYYYYYYYYYyyyyennyyyy
YYYYYVYYYYYYYYYyYyyyyyyyyyyyvENnyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyEnoyyy

e RN I
YYVYYIIIVYIVIYYIIIVYIVIVyIvYyIVEDOYYIYYIIIYYIVIVYIvIVyIvIvyIvyyyyvEnD



........

SIS S5 5559593935955550
VOV IYY TV IY TV VYT YYYVEDDY YV VY Yy VY Yy 9y Yy 99y yy
€OOYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYEDRSYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYY
390003355 YY SISy IY ISy ETOS Sy yS YUYy USyS vy sSysy
N e NN
N N N N T NN A
YYYYYYENOYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYEDEEYYYYYYYYYYYYYYYYYYYYYYYYY
A A
YYYYYYYYYENOYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYYEDEEYYYYYYYYYYYYYYYYYYYYYY
Y0005y ETIS VY3 Y9399 59593
N I NN,
YYYYYYyyVyyyyyayOyyyyyyyyyyvyyyyyyyyyyyyyyyyyyyyyyynoo00000000000000
000000000000000000y00000000000000000000000000000000000Y==5yYYYYyyyy
YYYYYyyyyyyyyyyyyyyyyyyyayonoooooooooo000000000000000000000000AD0O000

000000000000000000000000000000y0000000000000000000000000000000000
Oyessyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyyayonoooooooooooooooooooooooooon
000000yOoooooopoonooooooooonoooonoooonoooooyoooonoooonooooDooooooa

000000000000000000Yy0000000000000000000000000000000000080000000000
0000000000000000000000000Y25YYYYYYYYYYYYYYyyyyyyyyyyyyyyyyyyyayoooon
000000000000000000000000000000YD000000000000000000000000000000000
0yO0000ooo00000000000000000000000000000Y000000000000000000000000000
00000000y000o000000000000000000000000000000n0yY

This is logical : because Binic will no longer save settings on exit so if you don't
explicitly save settings, the next time you'll load Binic, he will have forget this.

Be careful, if you choose Yes Binic will only remember to no longer save settings
on exit, this doesn't save any other setting (like data type). This dialog box is not
equivalent to Save settings now command !
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The last command displays the About dialog box where you can find copyright
and version informations.

5. Advanced features

So far you've learn everything about Binic commands. You should be able to
convert a number from one representation to another and to use the clipboard for
quick and safe data exchange from or to you favorite text editor.

In this section, we'll have a look at some "advanced features" of Binic design to
ease its manipulation. This means the local menus.

Local menus are menus attached to an edit field. They offers options suited for
the particular field you selected. To open a local menu, simply click with the right
button on an edit field.
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Suppose you open Decimal edit field local menu by clicking with the right button
anywhere on the Decimal edit field, a popup menu with 2 options (Copy & Paste)
appears.

Be sure to click inside the rectangle which limit the edit field. Not above or
around. Be sure you use the right button of your mouse (or left button if you
inverted mouse button).
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With this menu you can simply copy edit field's content to the clipboard or paste
clipboard content into the edit field.

On a way, this is similar to the Copy and Paste command of the Edit menu. But
easier and quicker : here you don't have to specified which representation you're
working on. Since you open Decimal local menu, Binic understand you want to
manipulate decimal representation.
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Hexadecimal local menu is similar to decimal one : it offers the same options but,

off course, it copy/paste hexadecimal representation of current number.
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Binary local menu offers the Copy/Paste commands we already know (and this
time, they work on binary representation of current number).

But there's an extra command : Bit mask. This open bit mask you already use.
This command is strictly equivallent to Edit|Bit mask command.

6. Future improvements

Many things must be improve in Binic. This chapter intend to explain you the

main changes | planned for Binic. Feel free to comment this.

The most important lack, | think, is the lack of unsigned double word. This is due



to the language | used to program Binic : Turbo Pascal doesn't know anything
about unsigned double word. As long as | was the only user of Binic, it wasn't a
big problem but now that | consider distribution, | will fix it in further release.

| also plan to change the save settings option to to automatically save changes in
this menu. The original idea was : Binic won't save something on it's own when
you've just ask him to no longer save things automatically. Through experiment, |
found it is an useless complexity. This will be fix in next release.

It should also save the position of the window when it was close so that you won't
have to reposition it every time you start it. This will also be fix in further release.
Finally, | may write an help file.

If you like Binic please support those improvement by sending me a postcard (to
encourage me) as describe in the introduction.
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